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Part 1.  Some Basic Uses of MS Visio Professional / Pro  (2023)   
 
MS Visio Pro is used to…  

• express visual information in two-dimensions (on the x- and y- axes),  
• capture visual information,   
• convey or share visual information,  
• create and share .vtpx (Visio Template Package) templates (for usage by self and others),  
• enable problem solving through visualizations,  
• enable the drawing of workflows that may be diagram-validated / flow-checked for compliance (for the 

particular visual type, like cross-functional diagrams or BPMNs or “business process model and notation”),   
• enable the visualization of process diagram Excel data (through Visio Data Visualizer),  
• map websites (through Web Site Map),  
• create models (for software development, for project management…and others, sometimes with automated 

“checks” and validations),  
o and others  

 
[Note about Automated Validation:  Go to the Process Tab.   Select “Check Diagram.”  Define the ruleset that will be 
applied to validate the flowchart or BPMN or other file…   
 

 
 
Read the MS documentation here at https://support.microsoft.com/en-us/office/validate-a-structured-diagram-
c98ecf8e-17d9-48df-9414-d482a90bbbb2#bm1.] 
 
Featured Templates  
 
This tool features a number of (un)approved templates.  The templates have different backstories, nomenclature, and 
applied usages.   
 
Basic Diagram, Blank Drawing, Basic Flowchart, Organizational Chart, Detailed Network Diagram, Timeline, Cross-
Functional Flowchart, Work Flow Diagram, Office Layout, Basic Network Diagram, UML Class, Crow’s Foot Database 
Notation, Microsoft SharePoint 2013 Workflow, Home Plan, Brainstorming Diagram, Floor Plan, Basic Electrical, Block 
Diagram, Data Flow Diagram, Gantt Chart, Active Directory, BPMN Diagram (Business Process Model and Notation), 
Audit Diagram, Wireframe Diagram, Rack Diagram, (and) Calendar  
 

https://support.microsoft.com/en-us/office/validate-a-structured-diagram-c98ecf8e-17d9-48df-9414-d482a90bbbb2%23bm1
https://support.microsoft.com/en-us/office/validate-a-structured-diagram-c98ecf8e-17d9-48df-9414-d482a90bbbb2%23bm1
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Figure 1.  Some Available Templates in MS Visio Professional  

 
 
There are other schematics created by private companies as well.   
 
Some Categories of Available Visio Templates:  Network, Flowcharts, Software, Education, Business, Database, Floor 
Plans, and others 
 
Figure 2.  Categories of Available Visio Templates  

 
 

Custom templates may be created and saved in any of a number of template format types (Visio Template, Visio Macro-
Enabled Template, Visio 2003 – 2010 Template, and others).   

Custom stencil sets.  Custom stencil sets may be created and stored within Visio (in Documents - > My Shapes) in 
Windows.  New master shapes may be edited for this particular collection, and these may be set to show up in the 
regular image stencils in the left menu.  These images may be shared with others.  To create a custom set of stencils, 
many will begin with an extant set of stencils.  Right click and save as.  They will appear in the More Shapes -> My Shapes 
-> folder.  Those can be edited for later use in the left menu.   
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Figure 3.  Organizing a Personal Set of Shapes 

 
 
To add to favorites from existing shapes, just right-click in the left pane and add…   
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Figure 4.  Custom Stencil Sets (for Frequently Used Visuals)  

 
 
 
Check out Create a shape 
Check out Create, save, and share custom stencils   
 
To access a broad set of downloadable shapes and templates from the in-tool search, set up to search for visuals with 
OR, not AND.  The path is File -> Options -> Advanced -> Shape search -> “Any of the words (OR).”  
 
If you want a higher precision search, stay with the default setting of “All of the words (AND).”   
 
 
 
 
 
 
 
 

https://support.microsoft.com/en-us/office/create-a-shape-9acfe781-ae7e-43e5-ad69-9f3f89d0cf7c
https://support.microsoft.com/en-us/office/create-save-and-share-custom-stencils-a4c2235c-677d-4117-9673-1fef0a0ee22f
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Figure 5.  Setting Broader or Narrower Shape and Stencil Parameters in Visio  
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File-Type Imports and Exports:  The various file types that Visio Pro can engage may be seen in the following Import / 
Export table.   
 
Table 1.  Importing and Exporting Various Files to and from Visio  

Import Export 

 

 
 
Inputs and outputs are important because MS Visio Professional files may be part of a processing sequence.   

• Visio diagrams may be drawn with data as inputs…and templates as inputs…and others.     
• Visio diagrams may be post-processed in image-editing software, in computer aided design software, in digital 

photo albums, in digital slideshows, and others.   
 
[About vector vs. raster digital imagery:  Vector graphics are built by points, lines, and polygons on a two-dimensional 
plane, on the x and y axes. They scale up and down without visual degradation.  These vector graphics are images like 
.svg (scalable vector graphics), .pdf (portable document format), and eps (encapsulated postscript).  Raster images are 
drawn using square “dot matrix” “picture elements” which create the resolution of the image, and these can pixelate if 
stretched or if rendered at too low of resolution.  Raster images include .bmp (bitmap image file), .tif / .tiff (tagged 
image file format), .jpg / .jpeg (joint photographic experts’ group), .gif (graphic interchange format), and .png (portable 
network graphic).   
 
As a side note, there are newer image format types such as .webp (weppy) designed by Google as a lightweight but 
lossless sort of digital image format].     
 
 
 
 

https://developers.google.com/speed/webp
https://developers.google.com/speed/webp
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Pages in Visio  
 

• Pages may be added by clicking on the plus sign at the bottom left of the workspace.  Pages in a document may 
be navigated by clicking on the page name tabs at the bottom.  A file may be explored page by page by clicking 
ctrl and the page down arrow OR ctrl and the page up arrow (at the bottom right of the keyboard).   

• Another popular navigation is to use “navigation shapes.”  Place a shape on the page.  Right-click it, and in the 
dropdown menu, choose to edit hyperlinks.  A window will open.  Browse the sub-address and indicate where 
that shape should navigate to.  Use the relative path for hyperlink as below.   

• The description text field will show up when one hovers over the shape.   
 
 
Figure 6.  Edit Hyperlinks of the Selected Navigation Shape  

 
 
 
Hovering over the navigation shape shows the Description.   
 

 
Ctrl and click to follow the navigation.   
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Part 2.  A Bit about 2D Diagram Conventions   
 

1. Two-dimensional diagrams exist on a plane bordered by the conceptual x- and y-axes.  Two-dimensional visuals 
are the most common in academia although 3D ones are becoming more common.  The ambiguity in 3D imagery 
can be a challenge.   

 
2. Depending on the type of diagrams and their functionality, there are particular design conventions that should 

be applied. And there are common protocols and assumptions.  These should be adhered to in general.   
 

3. The reading of a diagram is usually from top to bottom and left to right.  In non-Western cultures, the reading 
may be from right to left.   

 
4. Diagrams should stand up to close scrutiny for all available assumptions within the visual.   

 
5. The respective sizes of shapes and objects may convey particular information.  Larger shapes and objects are 

often considered larger in terms of the representation of the phenomenon or fact. These also draw human 
attention.   

 
6. The proximity of shapes and objects may also convey information.  They may suggest some relatedness, in time, 

in practice, or other dimensions.   
 

7. The placement of objects within closed shapes conveys information.  They suggest belongingness to a larger 
phenomenon or set.   

 
8. Lines—their labels, their thicknesses, their connectivity, the presence/absence of arrows at the end, their dashes 

/ breakages / interruptions, their straightness or curviness, and other aspects—all convey information.  [Lines 
without arrows are indicative of associational links in undirected graphs; lines with arrows are indicative of 
directionality in directed graphs.] 

 
9. Color may convey information, or it may be decorative (alone).  Color should be of sufficient contrast to enable 

the understanding of the meaning.  Legends should be included to define the meaning of colors.  Areas with 
color should also be labeled with texture and / or terminology, so that information is not conveyed by color 
alone.   
 

10. Culturally, colors have different meanings, so these should be used with care.  The built-in color palettes and 
styles may be helpful in applying design to the visuals.   

 
11. Data visualizations should be sufficiently high contrast to be viewable.   

 
12. Text labels are important to identify contents (and dynamics) in a diagram.   

 
13. An informational descriptive name should be included with the visual, so if it becomes separated from its 

original context, it is still understandable in new contexts.  The date of creation should also be indicated.   
 

14. The information of a data visualization should be conveyed as clearly and coherently as possible.  Ideally, a “beta 
test” with the target audience should be done to ensure the clarity of the messaging.   
 

15. If underlying data was used to auto-generate the diagram, that source should be trustworthy and referenced.   
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Part 3.  Session Contents   
 

HOUR ONE:  Overview of MS Visio Pro  
 

• Brainstorming a visual or diagram (and defining conventions) | Google Images trawl of Visio imagery  
• Understanding the parts of a Visio Pro GUI  
• Understanding data-linked diagrams  

 
• Starting an MS Visio project (from scratch or a template)  

 
• Evolving the diagram using stencils and related shapes (and applying shape effects, rotating images)  
• Evolving the diagram using custom shapes  
• Adding text labels  
• Wiring up the elements  
• Placing an image in the diagram  
• Placing a data visualization from Excel in the diagram  
• Using pullout guides / guidelines  

 
• Using built-in connection points, adding connection points to custom shapes  
• Using the background grid for more precise layout  
• Lining up elements using auto-aligns  
• Applying built-in styling in Visio Pro  
• Saving the file as a .vsdx file (from Visio 2013, with Open Packaging Conventions based on XML)  
• Exporting image of the diagram in different visual formats  

 
• Reviewing the diagram for efficacy  
• Applying style to the diagram  

 
HOUR TWO:  Participant-Directed Explorations of MS Visio Pro  

 
• Exploring Excel templates and drawing from data (from Excel)  

 
• Drawing on different layers in Visio:  Objects can have their own layers…in Visio, particularly if they are more 

complex than a simple shape object.  Objects may be placed on “locked” layers that prevent them from being 
moved when adding other objects.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 



11 
 
 
Figure 7.  The Layer Properties Window  

 
 
 

• Reviewing Visio diagrams from the Social Web  
 

Figure 8.  Available Visio Diagrams from the Social Web (to Learn Conventions, to Understand Various Applications) 
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• Mapping a website (up to three layers deep) with Web Site Map  

 
Figure 9.  Mapping a Live Website Three Layers Deep  

 
 

• Using data to auto-draw a diagram (through Data Visualizer)  
 
Figure 10.  Autodrawing Diagrams from Data through Data Visualizer (on the subscription-based Visio Online Plan 2) 

 
 
For this data-to-diagram auto-drawing feature, the Visio Online Plan 2 is required.   
https://support.office.com/en-us/article/Create-a-Data-Visualizer-diagram-17211b46-d144-4ca2-9ea7-b0f48f0ae0a6 
 
A screenshot of how to set up a cross-functional Process Map is below (from the template in Excel).   
 

https://support.office.com/en-us/article/Create-a-Data-Visualizer-diagram-17211b46-d144-4ca2-9ea7-b0f48f0ae0a6
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Figure 11.  Setting up a Cross-Functional Process Map with Data from Excel and Ingested into Visio (per Data Visualizer above)  

 
• Using data to draw an organizational chart 

 
View (tab) -> Macros -> Add-Ons -> Business -> Organizational Chart Wizard  
 
There is an add-on that enables this drawing.   
 
Figure 12.  Using Add-ons to MS Visio Professional  
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Figure 13.  The Organization Chart Wizard Depicted from Existing Data  

 
 
(This feature also requires the subscription type of Visio Online plan…in Office 365…  )   
 

• Turning on your Developer powers:   
 
File -> Options -> Customize Ribbon -> Developer Button  
 
Figure 14.  Customizing the Ribbon in Visio Professional (to Enable the Developer Button)   
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• If the AutoSnap / Glue is too aggressive… 
 
View -> Visual Aids -> Dialog Launcher -> (toggle on/off) (sliders for intensity settings) 
 
https://support.office.com/en-us/article/add-connectors-between-shapes-eaa045c8-5ce9-4d4b-bd30-bb87dc8ac65a 
https://support.office.com/en-us/article/glue-or-unglue-connectors-c55370ae-a3c3-4468-9232-b32604f7252f 
 
Figure 15.  Controlling AutoSnap / Glue Intensity  

 
 

• Need some white space around a diagram?   
 
Add small “.” at 0.5 size around the image (four corners)…or use a background shape without color fill or any line to old 
out the edges of the image.   
 

• Want to use a higher-level diagram from Professional but only with Standard Visio?   
 
Keep a copy of the more sophisticated diagram type.  Open it in Standard, and you’ll be able to recreate that diagram 
form using the stencils and other functionalities of the less sophisticated version of Visio.   
 

• Want to “reverse-engineer” or transcode a .pdf “fixed” version of a Visio file back to an editable Visio format?   
 
It is possible to take the .pdf and turn it into a Windows metafile and then .tif and from there into a Visio file again. This 
requires Adobe Photoshop, the MS Suite, and Visio.  The shapes and lines move, but the macros do not.   
 

• Public facing diagrams and alternative text  
 
If creating a diagram for public consumption, share the fixed version as vector or raster graphics, not the raw Visio 
(.vsdx, .vsd, etc.).  Add alternative text (alt text) to meet federal Section 508 requirements for accessibility.    
 
https://support.office.com/en-us/article/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-
4fef-af65-16e252829d44 
 

• Others  
 
 

https://support.office.com/en-us/article/add-connectors-between-shapes-eaa045c8-5ce9-4d4b-bd30-bb87dc8ac65a
https://support.office.com/en-us/article/glue-or-unglue-connectors-c55370ae-a3c3-4468-9232-b32604f7252f
https://support.office.com/en-us/article/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44
https://support.office.com/en-us/article/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44
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Common Errors in Diagrams 

 
Global Issues 

 
• They do not follow the conventions of the particular diagram form.   

 
• The diagram is not properly named.   
• The diagram is not properly labeled.   
• The captioning is inaccurate.   
• The references in-text are inaccurate.   

 
• The logic flow of the visual does not work.   
• The diagram is not consistently integrated with the text (different terminology used in the visual vs. the text).   

 
• Layout is irregular, without alignments.   

 
• Processes depicted are incomplete.   
• Processes are insufficiently explicated in the flow.   

 
• Data informing the visualization are inaccurate.   
• Data informing the visualization are incomplete.   

 
• Visuals are derivative without proper copyright / IP citation.   

 
• The visual is in improper file format.   

 
• The spatial resolution of the digital image is incorrect.   

 
• The visual is blurred.   

 
• Accessibility considerations have not been addressed.  Alt-text is necessary for all visuals.  Designed 

interactivity in image maps should be accessible (to formal updated WCAG and Section 508 and other 
standards).   

 
Local Issues 

 
• Shapes are not used consistently.   

 
• The 2d pretending to be 3d illusion is broken.  (Some of the visuals show 3d or the z-axis…but then another 

part of the visual reverts to the 2d.)   
 

• Colors are not used consistently.   
• Colors, when used, do not have accessible levels of light-dark contrast for viewability.   
• Color is used alone to convey information (without additional labels for accessibility), such as in choropleth 

maps or intensity matrices.   
 

• The textual labels do not have consistent grammatical form.  
• The textual labels are misspelled.   
• Text is illegible.  
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• Font faces are inconsistent (in size).   
• Font faces are inconsistent (in font type).   
• Text is sloppy and falls outside of shape lines.   

 
• Language is biased (sexist, racist, age-ist, or some intersectional combination).    
• Subtle (vs. blatant) biases are present.   

 
And others.   
 

Good Practices for Making Diagrams  
 
There are a lot of moving parts to a diagram, so have a friendly colleague peruse the work and provide feedback.   
 
Use a consensus stylebook to guide quality of all diagrams in a team project.  This should include templates for typical 
diagrams, like Gantt charts and cross-functional diagrams and BPMN diagrams, and so on.  This should include color 
palettes (with precise color definitions). This should include spatial resolution and photo formats.  This should include 
font sizes and line widths.  This should include transparency / opacity guides.  If motion is used, framerates should be 
included.   
 
Machine vision and AI are improving over time, and they will one day be able to read diagrams accurately.  (Right 
now, there are abilities to read data plots and reverse these to numerical datasets.)  How to design diagrams that are 
machine readable will probably just require accurate drawing of diagrams and proper labeling.   
 
 

 
 
Presenter:   Dr. Shalin Hai-Jew  

ITS, Kansas State University  
  785-532-5262 
  shalin@k-state.edu  
 
 
MS Visio Pro Licensure at K-State:  https://www.k-state.edu/it/software/software-licenses/ms-visio-pro/index.html 
$25+ a year!  
 
Different versions of the tool may involve different costs, such as the online version, with additional capabilities.   
 
Digital Handout:   https://idme-test.ome.ksu.edu/VisioPro.pdf  (for Adobe PDF download)   
   https://idme-test.ome.ksu.edu/VisioPro.docx (for Word file download)  
 
 
 
 
Updated:  April 2023  

mailto:shalin@k-state.edu
https://www.k-state.edu/it/software/software-licenses/ms-visio-pro/index.html
https://idme-test.ome.ksu.edu/VisioPro.pdf
https://idme-test.ome.ksu.edu/VisioPro.docx
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